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About this document  

This document is a reproduction of the Online Help system provided with the user 
administrator control panel. It is designed for those who want to review Online Help 
information in hard copy format or off line.  

As you use this document, keep in mind that it is optimized for online presentation 
rather than for use as a book. It uses the fonts and formats preferred for online 
documents, and it presents information in a nonlinear style. Also, references that are 
clear online might not work as well in this format.  

To help you navigate this document electronically, bookmarks and contents links 
have been provided. The document’s internal links however, which are available in 
the online Help system, are disabled in this format.  

 
 
 
Quick-start tutorial 
for User Administrators 

HOME 

This quick-start tutorial is composed of interlinked Help-system topics that explain 
how to complete common tasks. Click a link below to learn about the task. Then click 
the quick-start links at the top or bottom of each topic to proceed through the 
tutorial.  

Quick-start topics: 

1. View your account information 

2. Change your account information 

3. Set up your email and Hosted Exchange 2003 services  
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Using the Help system 

This is the main online Help system. To find information quickly, browse the contents 
at left or use the search and index links above.  

How to print this Help system 

To browse through the topics: 

  In the left pane of the Help system, click to open a book ( ) and display 
the topics it contains. 

  In the left pane of the Help system, click to display the contents of a topic 
in the right pane. 

  If a book contains sub-books, click any book to open it and view a list of 
related topics. 

To find specific information: 

  Click , the help icon, on any page of the control panel. This opens the 
context-sensitive Help that provides information about the page. 

  When viewing a context-sensitive Help topic, click View Help Contents to 
open the main Help system and search for specific information. 

What do you want to do? 

Use the following icons to navigate the Help system: 

Icon Action 

 
Display the Help contents in the left pane. 

 
Search for information using keywords. 

 
Search for information using the index. 

 
View terms and definitions in the glossary. 

 
Return to the home page of the Help system. 

 
Print the current page. 
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If you have viewed several topics, go back to the 
previous topic. 

 
If you have viewed several topics, go forward to the next 
topic. 

 
Hide the contents and view the topic in the entire window 
(this option is not available through Netscape browsers).  

Printing Help 

To print individual topics, click the print icon at the bottom of each page. 

To print all topics at once, use the PDF version of this Help system. You can open it 
using the free Adobe Acrobat® Reader® program. The PDF version is approximately 
548 KB in size and 26 pages in length. 

 

When using the PDF version of Help, remember it is optimized for online presentation 
rather than for use as a book. It uses fonts and formats preferred for online 
documents, and it presents information in a nonlinear style. Also, references that are 
clear online might not work as well in this format. 

To help you navigate this document electronically, bookmarks and contents are 
provided. The document’s internal links however, which are available in the online 
help system, are disabled in this format. 
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Control panel overview 

 
About the user administrator control panel 

The user administrator control panel is the graphical user interface, or control panel, 
through which you manage your user account and service settings. 

Through this control panel you can: 

  View your account information 
  Change your account information 
  Set up the Hosted Exchange 2003 service (if enabled) 
  Configure FTP for the Windows Web Hosting service (if enabled) 

Home page 

The Home page of the user administrator control panel provides: 

  Login information. The user name you typed when you logged in appears in 
the upper left of the control panel next to the Home link. 

  Help and Log Out links. These links appear in the upper right of the control 
panel. Click Help to access the online Help system. Click Log Out to end your 
session. 

  Navigation panels. These panels appear on the left side of the control 
panel, and you use them to navigate between pages. The navigation panels 
are displayed in the closed state the first time you log in. However, their state 
is remembered whenever you log out. For example, if you open a navigation 
panel, then log out, the panel is displayed in the open state the next time you 
log in. 

  Shortcuts to common tasks. These links provide quick access to tasks you 
perform frequently. They are the same as the navigation panel links, 
however, some links on the navigation panels might not appear as shortcuts. 

  A link to the Quick-start Tutorial. The tutorial is composed of interlinked 
Help-system topics that explain how to complete common tasks. 

How to get to the Home page 

 
Session expiration 

For security, the user administrator control panel is designed with a 30-minute 
session expiration. This means that you are automatically logged out whenever your 
session is inactive, or no input is received, for 30 consecutive minutes. 

If your session expires, you need to log in again to use the control panel. You cannot 
change the time limit for session expiration. 
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Using the control panel 

Managing your account 

 
Viewing your account information 

QUICK-START TUTORIAL:  HOME  1  2  3 
 

Your account information includes personal information such as your name, address, 
and company information.  

To view your account information: 

  On the Configuration navigation panel, click Overview.  

Your user account information is displayed. 
NEXT QUICK-START TOPIC:  

CHANGE YOUR ACCOUNT INFORMATION 
  

User Account Information page 

The User Account Information page shows the information available about your user 
administrator account. You can change any of the information on this page except 
your username.  

This information includes: 

General Information 

  Username. The name you type in the Username text box when you log in to 
the User Administrator control panel. This is also your email address. 

  External Email. An email address, outside of the organization, at which you 
can be contacted. This address is used for system messages, such as 
warnings about mailbox disk space limits. If no external email address is 
provided, you do not receive warning messages if your mailbox exceeds your 
disk space limit. 

  Contact information and company information. You can change this 
information at any time. 

Service Information 

  Exchange Server Information. This information is displayed if Hosted 
Exchange 2003 is enabled for your account.  

o Exchange server hostname. The host name of the Exchange server hosting 
your mailbox. 

o Exchange Server IP Address. The Internet Protocol (IP) address of the 
Exchange server. 

o Windows Domain Name. The service provider's domain name. This is the 
domain name that you must use when logging on to OWA. 
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o Windows Domain NetBios Name. The service provider's NetBios name.  

o Mailbox Information 

o Disk Quota Allocated. The maximum disk space allowed for your mailbox. 

o Current Disk Usage. The disk space used by your mailbox. 

o SAM Account Name. The user name that you use when logging on to OWA 
or Outlook. 

o Message Limits 

o Deleted Items Retention Time. The maximum duration (in days) that 
emails deleted from Outlook Web Access (OWA) or Microsoft Outlook are 
retained on the Exchange Server.  

o Maximum Outgoing Message Size. The maximum limit on the size of each 
message sent out from the mailbox 

o Maximum Incoming Message Size. The maximum limit on the size of each 
message received into the mailbox 

o Distribution List Membership. Displays the list of distribution lists that you 
are a member of. 

o Email Addresses. Displays the list of your email addresses. 

How to get to the User Account Information page 

 
Changing your account information 

QUICK-START TUTORIAL:  HOME  1  2  3 
 

You can change any of your account information with the exception of your 
username. Only your organization administrator can change the service settings 
displayed on the account information page, however. 

To change your account information: 

1. On the left navigation panel, click Edit Configuration. 

2. Change your user information as needed, then click Save. 
NEXT QUICK-START TOPIC:  

SET UP YOUR EMAIL AND HOSTED EXCHANGE 2003 SERVICES 

Changing your password 

You can change your password at any time. 

To change your password: 

1. On the left navigation panel, click Change Password. 

2. On the Change Password form, type your current password in the Old 
Password text box. 

3. In the New Password text box, type your new password. Passwords are 
case sensitive, cannot contain spaces, and have to be at least one character 
in length. Allowed characters include: a-z A-Z 0-9 , . - _ / + $ ~ : % @ !  

4. In the Confirm New Password text box, retype your new password. 
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5. Click Save. 

Your password is changed. The next time you log in, you need to use the new 
password. 

Managing services 

Hosted Exchange 2003 

Setting up Hosted Exchange 2003 
QUICK-START TUTORIAL:  HOME  1  2  3 

 

Hosted Exchange 2003 is a service that provides email and collaboration services. If 
your organization administrator enables Hosted Exchange 2003 for your account, you 
can manage many of the service features from the user administrator control panel. 
This topic lists the setup tasks for Hosted Exchange 2003. 

Setting up Microsoft Outlook as your email client 

If you have Microsoft Outlook installed on your computer and configured as your 
default email client, you can set up your Microsoft Outlook email profile for Hosted 
Exchange 2003 from the user administrator control panel using a single click. 
Instructions 

Setting up email forwarding 

If you have another email account that you use as your primary email account, you 
can set up Hosted Exchange 2003 to forward your email messages to that account. If 
you want to be able to get your messages on either account, you can choose to keep 
copies of forwarded email messages in your Hosted Exchange 2003 account. 
Instructions 

Using Outlook Web Access (OWA) 

If it is enabled for your account, you can open Outlook Web Access (OWA) from the 
user administrator control panel. OWA enables you to view your email over the Web. 
There is a link available on the shortcuts page for quick access to your OWA server. 
Instructions 

Setting up ActiveSync 

ActiveSync is a feature that synchronizes your offline email, calendar, and contacts 
with the Exchange 2003 server. You can use ActiveSync with Pocket PC and 
SmartPhone devices. Instructions 

Installing the Exchange Server Health Monitor 

The Exchange Server Health Monitor (ESHM) enables you to view the status of the 
Exchange server You can use ESHM to troubleshoot network-related issues with your 
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mailbox. To use ESHM, you need to install an ActiveX client monitoring the health of 
your Exchange server. Instructions 

 
RETURN TO QUICK-START HOME 

  

Viewing your Hosted Exchange 2003 options 

The View Service Configuration page for Hosted Exchange 2003 shows the options 
enabled for your account. Only your organization administrator can change these 
options. For each feature: 

  indicates the feature is enabled 
  indicates the feature is not enabled 

Information on this page includes: 

General Resource limits 

  Disk Space Allocated. The maximum server disk space, in megabytes, 
available to the mailbox for Hosted Exchange 2003. Only your organization 
administrator can change this amount. 

  Disk space Threshold. The percentage of disk-space usage that triggers 
disk-space alerts. If your organization administrator enables Hosted Exchange 
email notifications, you receive an email alert when the disk-space usage of 
your mailbox reaches this percentage. This enables you to take action and 
delete messages or request additional resources before you run out of disk 
space. If your mailbox exceeds the disk space allocated to you, these alerts 
are sent to your external email address, since you cannot send or receive 
messages from your organization mailbox if it is full. 

  Current Disk Usage. The amount of disk space, in megabytes, currently 
used by your mailbox. 

Mailbox Access Options. The options enabled for your account. Only your 
organization administrator can change these options.  

  POP: Post Office Protocol (POP) is a protocol used to retrieve email 
from a mail server. POP downloads email from the server and store it 
on the local machine. POP works best when accessed using a single 
computer. Accessing POP using multiple computers tends to sprinkle 
messages across all of the computers used for email access. 

  IMAP:Internet Mail Access Protocol (IMAP) is a protocol used to 
access email from a central mail server. It allows users to access email 
on the mail server like it were on a local hard drive; however the email 
is actually left on the server. The mail, can therefore, be accessed 
from multiple machines without having to transfer files or messages 
manually.   

  MAPI: Messaging Application Programming Interface (MAPI) is a set of 
object-oriented functions that provide messaging capabilities. 

  OWA: Outlook Web Access (OWA), is a Microsoft server-side 
application used to retrieve and work with data stored on a remote 
Microsoft Exchange Server computer using an Internet browser.  It 
provides Web-based public access to Microsoft Exchange Server email, 
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public folders, calendar information, Address Book, contacts, and 
shared applications.  

Mobility Options 

  OMA: Microsoft Outlook Mobile Access (OMA) provides mobile phone 
browser access to Exchange servers for xHTML (WAP 2.0), HTML 
mobile phone, Compact HTML (cHTML) on i-Mode devices (in Japan), 
and PDA browsers such as Pocket Internet Explorer on Windows 
Powered Mobile Devices. 

  User Initiated Synchronizations (ActiveSync): User Initiated 
Synchronizations is a feature that synchronizes email with the 
Exchange 2003 server and maintains offline copies of email, calendar, 
and contacts. 

  Up-to-date notifications: Up-to-date notifications provides the 
ability to keep data on mobile devices up to date, using methods 
provided by Exchange 2003. User Initiated Synchronization feature is a 
pre-requisite for this feature. 

Message limits 

  Deleted Items Retention Time: The maximum duration (in days) that 
email messages deleted from Outlook Web Access (OWA) or Microsoft Outlook 
are retained on the Exchange Server. Deleted email messages can be 
recovered within the specified duration before being automatically deleted.  

  Maximum Outgoing Message Size: The maximum limit, stated in KB, of 
the size of each message sent out from the mailbox. 

  Maximum Incoming Message Size: The maximum limit, stated in KB, of 
the size of each message received into the mailbox. 

Other Options 

  Show in Address List. Shows the your account information in the address 
book.  

 If this option is not selected, you cannot access the mailbox using Outlook. 
You can use only OWA, OMA, POP, IMAP, and Outlook Express to access 
the mailbox.  

  Distribution List Membership. The distribution lists to which you belong. 
You receive messages sent to these distribution lists. 

  Email Addresses. The email addresses that direct email to your mailbox. 

Login Information for Microsoft Outlook/OWA/OMA. The username required 
for access to these features. 

Login Information for POP/IMAP clients.  The username required for access to 
these features. 

Mail Server Information. The servers used for your email account. 

How to get to the View Service Configuration page 

Setting up email forwarding 
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You can forward the email messages sent to your Hosted Exchange 2003 mailbox to 
another email address. 

 You can forward your email messages to one external email address only. 

To set up email forwarding: 

1. On the user administrator Home page, click Set Email Forwarding.  

2. Select the Enable Forwarding check box to enable the email forwarding 
feature for your mailbox. 

3. In the Forwarding Email Address text box, enter the external email 
address where you want the email messages to be forwarded. 

4. Select the Save a copy on server check box to save copies of your 
forwarded email messages on the Exchange 2003 server. If you do not select 
this check box, the email will be forwarded to the external email address and 
deleted from the Exchange 2003 server. 

5. Click Save. 

Setting up ActiveSync 

ActiveSync is a feature that synchronizes your offline email, calendar, and contacts 
with the Exchange 2003 server. You can use ActiveSync with Pocket PC and 
SmartPhone devices. 

To use ActiveSync: 

  Your organization administrator needs to enable the feature for you. 

  You need to use a computer with following operating systems: Windows 9x, 
Windows ME, Windows 2000, or Windows XP. 

  You need to have a Pocket PC or SmartPhone device and cradle attached to 
your computer. 

  You need to set up the device as described in this topic. 

To set up Pocket PC or SmartPhone for ActiveSync: 

1. Install ActiveSync version 3.7 (or above) on your computer if it is not already 
installed. You can obtain this program from your Pocket PC or SmartPhone 
manufacturer, or download it from Microsoft. 

2. Connect your Pocket PC or SmartPhone cradle to your computer if it is not 
already connected. Remove the Pocket PC or SmartPhone device from the 
cradle. 

3. If you have an ActiveSync partnership already created, delete it: Start the 
ActiveSync program, then from the File menu click Delete Partnership. 

4. Log in to the User Administrator control panel. 

5. On the home page, in the Hosted Exchange 2003 area, click Desktop 
ActiveSync Setup. 

6. On the Desktop ActiveSync Setup page, click Download. This downloads the 
setup program ASyncProc.exe to your computer. 

7. When the download is complete, run the program. 
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8. Place your Pocket PC or SmartPhone device in the cradle. ASyncProc.exe 
configures your device for ActiveSync in less than two minutes. 

9. When configuration is complete, delete the ASyncProc.exe from your 
computer. 

Whenever you place your Pocket PC or SmartPhone in the cradle, your email, 
calendar, and contacts available through the phone are synchronized with the 
Exchange 2003 server automatically. 

Using ESHM 

Installing the Exchange Server Monitor 

The Exchange Server Monitor is an application that monitors the status of the 
Microsoft® Exchange server that hosts your Hosted Exchange 2003 mailbox. If your 
organization administrator enables the feature for your account, you can install and 
use the Exchange Server Monitor on your local computer. 

To install and set up the Exchange Server Monitor: 

1. In the Hosted Exchange 2003 area of the Home page, click Exchange 
Server Monitor Setup. The Exchange Server Health Monitor Setup page 
opens. If this link is not available, the feature is not enabled for your account. 

2. Click the Click here link to set up Exchange Server Monitor. 

3. Click OK in the configuration window. 

 The configuration window opens only if you are setting up the Exchange 
Server Monitor for the first time. 

The Exchange Server Monitor is installed on your computer and is available as 

a system tray icon  on the Windows task bar. 

Uninstalling the Exchange Server Monitor 

You can uninstall the Exchange Server Monitor from your local computer if there is a 
problem with the installation or if you want to remove the monitor. 

To uninstall the Exchange Server Monitor: 

1. Open Internet Explorer. 

2. Navigate to Tools > Internet Options. 

3. Click the Settings tab in the Temporary Internet files area. The Settings 
window opens.  

4. Click the View Objects tab. The Download Program Files page opens. 

5. Right click InstallESHM Class and select Remove. 

6. Open Windows Explorer.  

7. Navigate to the C:\ENSIM\ESHM directory. Right-click the directory and 
select Delete. 

8. Navigate to Start > Run. 

9. In the Open text box, type regedit. The Registry Editor is displayed.  
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10. Navigate to HKEY_LOCAL_MACHINE\Software\Ensim 
Corporation\Exchange Server Health Monitor. Right-click and select 
Delete. 

The Exchange Server Monitor is uninstalled. 

Configuring your mailbox to use Outlook 

Configuring Outlook using the User interface 

Configuring Outlook using the control panel 

You need to configure your Outlook mail client to send and receive email from the 
Exchange 2003 server. 

 If you do not have Outlook and are using another mail client (such as 
Microsoft Outlook Express) to send or receive your email, you must 
perform a manual setup.  

To configure your Outlook mail client:  

1. In the Hosted Exchange 2003 area of the user administrator control panel, 
click Mail Client Setup. The Outlook Client Setup page is displayed. 

2. Click the appropriate link to configure your Outlook mail client. 

o If you are a Windows 2000 systems user with administrative rights, click One 
Click Setup.  

o If you are a Windows 9x, ME, 2000, or XP user, click Download Executable. 

The setup configures your Outlook mail client profile and installs the Outlook 
Autologin application on your computer. You can use the Outlook Autologin 
application to change the configuration of your Outlook profile.  

The program checks to see if there is an existing profile for your mail client. If 
no profile is found, the program creates a new profile using default profile 
name. If a profile is found, the program displays a dialog box with the 
following settings: 

o Profile Name. A default profile name. You can overwrite any existing profile 
by selecting Existing Profile or you can type a new profile name. 

o Outlook 2003 Options. For Outlook 2003, this option is enabled; for 
previous versions of Outlook, it is disabled.  

o Local Copy. If checked Outlook is configure using Local Copy option enabled.  

o Connect Using HTTP. If checked Outlook is configured to connect using 
HTTP. 

 The Outlook Autologin application verifies your Outlook credentials 
automatically each time you access Outlook.  

 When creating your Outlook profile, you might receive a message asking 
you to configure the profile manually. When creating the profile manually, 
you might receive another error message that the name could not be 
resolved. If you get this error, it indicates that your mailbox cannot be 
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accessed using Outlook. You can either verify your connection to the mail 
server or access your mailbox using OWA, Outlook Express, POP, or IMAP. 

Changing the Outlook configuration using the Outlook Autologin 

The mail client setup configures your Outlook mail client profile and installs the 
Outlook Autologin application on your local computer. When the installation is 

complete, the following icon appears in the Windows system tray: .  

 If you change the password you use to log on to the user administrator 
control panel, you must ensure that you change the password settings 
using the Outlook Autologin. 

To change the Autologin configuration of your Outlook mail client: 

1. In the Windows system tray of your local computer, right-click , then click 
Configure. 

 The Outlook Autologin is available only if you have set the Outlook 
configuration using the user administrator control panel. 

2. Enter and confirm the new password.  

 When you change your password, you cannot log on to Outlook without 
updating Autologin. 

3. Select the refresh interval. The refresh interval is the time taken to load 
Outlook using the Autologin feature. 

4. Click Ok. 

The next time you open your Outlook client, you are automatically routed to 
your Exchange 2003 server mailbox.  

 If you need to re-configure Outlook using Outlook Autologin, you must first 
uninstall Outlook Autologin and then set the Outlook configuration in the 
user administrator control panel. 

Uninstalling the Outlook Autologin application 

You might need to uninstall Outlook Autologin if: 

  Outlook Autologin has not been installed correctly. 

  You receive an email from your system administrator informing you that the 
Exchange service has moved. You will have to uninstall the application and 
then reinstall it to set it up again.  

To uninstall the Outlook Autologin application: 

1. Open the Internet Explorer 

2. Navigate to Tools > Internet Options 

3. Click the Settings tab in the Temporary Internet files area. The Settings 
window opens.  

4. Click the View Objects tab. The Download Program Files page opens. 

5. Right click on ProfConfCtrl, then select Remove. 
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Outlook Autologin is uninstalled. You can now log on as the User administrator 
and setup the mail client again. 

Manually configuring Microsoft Outlook 

Accessing your mailbox using Microsoft Outlook 

To access your mailbox using Microsoft Outlook, you need to configure several 
Outlook email service options.  

  If you have not used Outlook on your computer, a setup wizard, which runs 
automatically when you start Outlook, helps you select options and make the 
connection to the Exchange 2003 server. 

  If you have previously used Outlook to manage email on your computer, you 
need to set Outlook options without the setup wizard. 

 Before setting the Outlook options, make sure Microsoft Outlook is 
installed on your computer and the network properties are configured 
correctly. 

Setting Outlook options without the setup wizard 

If you have previously used Outlook to manage email on your computer, you need to 
select Outlook options for Hosted Exchange 2003 manually.  

 Before setting the Outlook options, make sure Microsoft Outlook is 
installed on your computer and the network properties are configured 
correctly. 

To set Outlook options without the setup wizard: 

1. Start Outlook by clicking the Microsoft Outlook icon on your desktop. 

2. Choose Tools > Options. 

3. In the Options window, click the Mail Services tab. 

4. Click the Reconfigure Mail Support... tab at the bottom of the window.  

5. In the Email Service Options window, select Corporate or Workgroup, then 
click Next.  

6. Click OK to close the Options window, then close Outlook. 

7. From the Windows Start menu, select Settings > Control Panel.  

8. On the Control Panel window, double-click the Mail icon.  

9. On the Profile Properties window, click Add..., then select Microsoft 
Exchange Server.  

10. Click OK. 

11. In the next window, enter the Exchange 2003 server name and your mailbox 
username.  
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12. Click Check Name, then enter your mailbox username and password when 
prompted.  

 To confirm the User Name and Domain: 
  

o On the User Administrator Home page, click View in the User 
Settings area. 
  

o Scroll down to the Hosted Exchange 2003 in the Service 
Information area. The SAM Account Name displays the user name 
in the valid format. The Windows Domain Name field displays the 
valid domain name. 

Your mailbox is displayed. 

 When creating your Outlook profile, you may get an error message that 
the name could not be resolved. If you get this error, Outlook cannot 
access your mailbox. Verify that the mail server is reachable and update 
host file entries if required, or access your mailbox using OWA, Outlook 
Express, POP, or IMAP. 

Setting your Outlook profile using the setup wizard 

If you have not used Outlook on your computer, a setup wizard, which runs 
automatically when you start Outlook, helps you select options and make the 
connection to the Exchange 2003 server. 

 Before setting the Outlook options, make sure Microsoft Outlook is 
installed on your computer and the network properties are configured 
correctly. 

To set Outlook options with the setup wizard: 

1. Right click the Microsoft Outlook icon on your desktop. 

2. Select Properties. 

3. On the Profile Properties window, click the Show Profiles tab. 

4. In the Mail window, click Add. 

5. In the Microsoft Outlook Setup Wizard, select the Use the following 
information services option button and then select the Microsoft 
Exchange Server check box.  

6. Click Next. 

7. On the next screen, enter the name of your Outlook profile. This helps 
distinguish the profile from other profiles. 

8. Click Next. 

9. On the next screen, enter the Exchange 2003 server host name and your 
Mailbox user name. You should have received these from your organization 
administrator.  

10. Click Next. 

11. In the next screen, click No in response to the question, Do you travel with 
this computer?  
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12. Click Next. 

13. In the next screen, click Finish. The Mail window opens. Click the Properties 
tab. 

14. On the Settings Properties window, click the Properties tab. 

15. On the next window, click the Check Name tab. A password window opens. 

16. In the User Name field, enter your mailbox user name in the correct format. 

17. In the Password field, enter your mailbox password. 

18. In the Domain field, enter the domain name of the Exchange 2003 server. 

 To confirm the User Name and Domain: 
  

o On the User Administrator Home page, click View in the User 
Settings area. 
  

o Scroll down to the Hosted Exchange 2003 in the Service 
Information area. The SAM Account Name displays the user name 
in the valid format. The Windows Domain Name field displays the 
valid domain name. 

Outlook starts and your mailbox is displayed. 

 When creating your Outlook profile, you may get an error message that 
the name could not be resolved. If you get this error, Outlook cannot 
access your mailbox. Verify that the mail server is reachable and update 
host file entries if required, or access your mailbox using OWA, Outlook 
Express, POP, or IMAP. 

Accessing your mailbox using Microsoft Outlook Web Access  

 To connect to an OWA server, you must have a compatible Internet 
browser such as Microsoft Internet Explorer 3.02 (or later) or a third-party 
Internet browser that supports frames.  

To access Microsoft Outlook Web Access: 

1. Open the User Administrator Home page. 

2. Click Outlook Web Access.  

3. In the User Name field, enter your mailbox user name. 

 Always enter your user name using the format:  
<user name>@<Organization Domain Name> where  
<Organization Domain Name> is the domain name of the organization 
that is hosting mailbox.  

4. In the Password field, enter your mailbox password. 

5. In the Domain field, enter the domain name of the Exchange 2003 Server.  

 To confirm the user name and domain:  
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o 1. On the User Administrator Home page, navigate to the User 
Settings area and click View. 
  

o 2. Scroll down to Hosted Exchange 2003 in the Service 
Information area. The SAM Account Name displays the user name 
in the valid format. The Windows Domain Name field displays the 
valid domain name. If a front-end server is installed, the Domain 
field is not enabled. 

 You must enter the domain name for the Exchange 2003 Server, not the 
organization. 

6. Click OK. Upon user name and password authentication, the OWA interface is 
displayed.  

Accessing your mailbox using Microsoft Outlook Mobile Access  

 To connect to an Outlook Mobile Access (OMA) server, you must have a 
xHTML (WAP 2.0), HTML mobile phone, Compact HTML (cHTML) on i-Mode 
devices (in Japan), and PDA browsers such as Pocket Internet Explorer on 
Windows Powered Mobile Devices. 

To access Microsoft Outlook Mobile Access: 

1. On the user administrator home page, click Outlook Mobile Access.  

2. In the User Name field, enter your mailbox username. 

 Always enter your user name using the format:  
<user name>@<Organization Domain Name> where  
<Organization Domain Name> is the domain name of your Organization 
that is hosting mailbox.  

4. In the Password field, enter your mailbox password. 

5. In the Domain field, enter the domain name of the Exchange 2003 Server.  

 To confirm the user name and domain:  
  

o On the User Administrator Home page, click View in the User 
Settings area. 
  

o Scroll down to Hosted Exchange 2003 in the Service Information 
area. The SAM Account Name displays the user name in the valid 
format. The Windows Domain Name field displays the valid 
domain name. 
  

o If a front-end server is installed, the Domain field is not enabled. 

 You must enter the domain name for the Exchange 2003 Server, not the 
organization. 

6. Click OK. Upon user name and password authentication, the OMA interface is 
displayed.  
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Troubleshooting 

Troubleshooting Hosted Exchange 2003 issues 

This topic explains how to resolve issues that might arise with Hosted Exchange 
2003. 

Mailbox disk space issues 

If your mailbox exceeds the amount of disk space allocated to it, your administrator 
sends an email message informing you that you have exceeded your disk-space 
limit. The email message is sent to the external email address provided for your 
account, since your Hosted Exchange 2003 mailbox cannot receive email after it 
exceeds its disk-space allotment. If no external email address is provided for your 
account, you do not receive the disk space warning. 

See Accessing your mailbox when usage exceeds quota for more information. 

Issues related to the move of Hosted Exchange 2003 service  

If the Hosted Exchange 2003 service is moved, your administrator sends an email 
informing you of the move. Do not attempt to access your services while the Hosted 
Exchange service is being move.  

After the move, you need to re-configure Microsoft Outlook, Outlook Express, and 
ESHM. 

 You need to uninstall ESHM before configuring it. 

Opening the Outlook mailbox 

You might not be able to open your Outlook mailbox after manually setting your 
Outlook profile. If this happens, please verify that the mail server is reachable and 
update host file entries if required.  

Accessing your mailbox using OWA 

You might not be able to access your mailbox using OWA. If this happens, please 
check whether the host file contains the relevant mail server entries and update the 
host file entries if required.  

Public folders 

If you have contributor permissions on a public folder and try to access the public 
folder through OWA, an Authentication window is displayed. You must click Cancel 
to be able to create items in the public folder. 

Accessing your mailbox when usage exceeds disk-space 
resource limits 



Using the control panel 

Online Help for the User Administrator Control Panel     21 of 29 
 

Organization administrators specify mailbox disk-space resource limits. These limits 
are set on the Exchange server. When the mailbox usage exceeds the specified limit, 
an email message is sent to the external email address specified for your account. If 
no external email address is specified for your account, you will not see the warning 
message since you cannot send and receive email after your mailbox exceeds its 
disk-space limit. 

If your mailbox exceeds its disk-space limits, you have two options: 

  Ask your organization administrator to increase your mailbox disk-space 
resource limits. 

 It is important that you wait for some time before you attempt to send and 
receive email messages after the resource limit is increased. It takes more 
time for you to send email messages than to receive them. 

  Delete email messages from your mailbox to increase the available disk 
space. 

Updating the host file 

You need to make sure the host file on your computer contains the current entries 
for the Exchange server used by your organization. 

To update the host file on your computer:  

1. Access the host file at one of the following locations.  

o Windows NT/2000 machines: 
systemroot%\system32\drivers\etc\hosts 

o Windows 9X/ME machines: 
%systemroot%\hosts 

Example: c:\winnt\system32\drivers\etc\hosts  

2. Open the host file and use a text authoring utility, such as Notepad, to add 
the following information to the host file: 

<IP Address> <Full name of the mail server> <Short name of the 
mail server> 

Example: 10.70.68.121    vm121.vm70.com    vm121  

3. Save the file. 

Verifying your connection to the mail server 

Before you can set up Microsoft Outlook manually, you must verify that you can 
reach the mail server from your current desktop or laptop. 

To ensure the mail server is reachable:  

1. Navigate to Start > Run. The Run window displays. 

2. In the Open text box, type ping <exchange server name>. Example: ping 
vm121.vm70.com.  

3. Click OK. 

A window opens and displays one of the following messages: 
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o Reply From: <IP address>. Example: Reply From : 10.70.54.201  

o Request Timed Out 

o Unknown host 

4. The Reply From message indicates that the mail server is reachable. If you 
receive the Request Timed Out or Unknown host message, you must 
either contact your organization administrator or update the host file on your 
computer.   

Windows Web Hosting 

About Windows Web Hosting 

Windows Web Hosting provides IIS FTP, part of the Microsoft Internet Information 
Server service, that allows you to upload and download files to a wide variety of 
systems. 

IIS FTP is a part of the Microsoft Internet Information Server (IIS) that manages the 
File Transfer Protocol (FTP) service. The File Transfer Protocol (FTP) client application 
is used to transfer files across the Internet and allows you to connect to any system 
that has a valid Internet address and contains an FTP server program. It allows you 
to transfer files between a wide variety of systems. 

 You need to have an FTP program to upload or download files using FTP. 

IIS FTP service 

FTP configuration overview page 

The FTP configuration overview page shows the IIS FTP features available to your 
account. For each feature: 

  indicate the feature is enabled 

  indicates the feature is not enabled 

IIS FTP is a part of the Microsoft Internet Information Server (IIS) that manages File 
Transfer Protocol (FTP) service. The File Transfer Protocol (FTP) client application is 
used for transferring files between your personal computer and an FTP site. 
Depending on the permissions enabled for your account, you can connect to any 
system that has a valid Internet address and contains an FTP server program, and 
you can transfer files between a wide variety of systems. 

 The default FTP site refuses FTP connections to name-based sites unless 
you specify the port number, which is shown on this page. 

Information on this page 

On this page you can view the following information: 

  General Organization Information 

o URL: The URL of your FTP site. 
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o Port Number (used for name-based organizations):  The FTP port 
number represents the port on which the service is running. 

o User Permissions  

o Allow File Download (Read): Allows you to download files and list 
directories. 

o Allow File Upload (Write): Allows you to upload files. 

o Feature Configurations  

o Enable Logging visits by the user: Records visits to the directory in a log 
file. Visits are recorded only if logging is enabled for this Web site. 

How to get to the FTP configuration overview page 

1. Open the User Administrator Home page. 

2. In the IIS FTP service section, click Overview.  

Changing FTP configuration 

You can change the FTP settings as needed. These settings include: 

  Enable Logging Visits by User. If this setting is enabled, the IIS FTP 
service records your visits to the directory in a log file. You can select this 
feature only it is enabled for your organization. 

How to get to the FTP configuration page 

1. On the user administrator home page, in the IIS FTP Service shortcuts 
section, click Overview.  

2. Click Edit to change FTP configuration. 

Windows SharePoint 

About Windows SharePoint 

Windows SharePoint is a service that enables you to use a Web site to capture and 
share ideas, information, communication, and documents.  

SharePoint Web sites facilitate team participation in discussions, shared document 
collaboration, and surveys. Site content is accessible from both a Web browser and 
through clients that support Web Services. The document collaboration features 
allow for easy check in, check out, and document version control. 

Using Windows SharePoint 

You can access the Windows SharePoint user interface by clicking a link on the Home 
page of the user administrator control panel.  

 To use the Web site features of Windows SharePoint, your computer must 
be running Microsoft Internet Explorer 6.0 or later or Netscape Navigator 
6.2. Internet Explorer 6.0 or later produces the best results. 
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Glossary 

A 
Address Book: A program that displays recipient names (in the form of mailboxes, 

aliases, and distribution lists) in the directory. The Address Book can contain 
one or more address lists. 

C 
collaboration: A feature that provides enterprises with Web-based Exchange 

solutions to enable users to easily manage their email and personal calendars, 
address lists, public folders, schedule meetings, manage contacts, and access 
shared applications on the Exchange 2000 Server. 

D 
distribution lists: A group of mailboxes used to circulate topic discussions within 

the Organization. When a message is sent to a distribution list, it is 
automatically forwarded to all members in the list. Distribution lists allow 
access to multiple mailboxes using a single source. 

E 
external contacts: The people and business associates external to an organization. 

I 
Internet Mail Access Protocol: see IMAP. 

M 
mailboxes: A private repository for email that is created within an Organization and 

resides on the Exchange 2000 server. All users must have a mailbox to send 
and receive messages. 

MAPI: Messaging Application Programming Interface. A system built into Microsoft 
Windows that enables different -mail applications to work together to 
distribute mail. As long as both applications are MAPI-enabled, they can share 
mail messages with each other. 

messaging: A feature that provides enterprises with anywhere, anytime access to 
their mailbox using Microsoft Outlook® Web Access (OWA). 

N 
navigation panel: The panel that appears on the left side of the control panel. You 

use the links in this panel to navigate between pages of the control panel. 
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O 
organization: A group of individuals, usually collected into a company or business 

unit, that contracts with a service provider for its services. 

Outlook: Microsoft's premier email and collaboration client. It allows users to easily 
manage their email and personal calendars, schedule meetings, and manage 
contacts. It is used primarily by customers who rely on the Microsoft 
Exchange Server for advanced messaging, calendaring, and custom 
collaboration applications within their Organization. Outlook works with any 
communication system that supports MAPI. 

Outlook Express: Microsoft Outlook Express, available with Microsoft internet 
Explorer 5.0 and later, offers standard email and news access and is designed 
for use with any mail server that supports POP3 and IMAP. Outlook Express 
supports most email,news, and directory standards, and offers more features 
than other basic email packages. 

Outlook Web Access: see OWA. 

OWA: Outlook Web Access. A Microsoft server-side application used to retrieve email 
from a mail server. OWA allows users to access email, calendar information, 
and shared applications through a Web browser. 

P 
POP: Post Office Protocol. A protocol used to retrieve email from a mail server. POP3 

downloads email from the server and stores it on the local machine. 

Post Office Protocol: see POP. 

public folder permissions: Permissions that determine the right to access, create, 
and modify the public folder and it's contents. 

public folder role: A role determines the permissions to access, create, and modify 
the public folder and it's contents. 

public folders: Folders that store messages or information that is shared with users 
within an organization. 
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